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[bookmark: _Toc342311669]Lesson Plan
Lesson Objectives
At the completion of this lesson, using speech commands, you will be able to:
1. Configure Dragon NaturallySpeaking ("Dragon") for use with Microsoft Word.
2. Understand how Dragon works with the Ribbon Interface.
3. Start Word, create, open, and close documents, and change views.
4. Navigate and select text.
5. Understand formatting and fonts.
6. Add headers and footers to your document.
7. Save Word documents.
8. Print Word documents.
9. Use Spell Check and AutoCorrect options.
10. Use the Find and Replace feature.
11. Work with tables.
12. Work with multiple documents.
Length of Lesson
4 hours
[bookmark: _Toc336434181][bookmark: _Toc342311670]Background and Rationale
Dragon NaturallySpeaking is "speech recognition" software that is available to assist employees who have a broad range of upper body mobility impairments that restrict their ability to use a mouse or keyboard.  Dragon speech recognition reduces the pain and frustration of daily computer tasks by helping reduce the number of keystrokes and mouse clicks needed to manage computer applications – all by voice commands.
Utilizing Optional/Alternative Command Language
More often than not, there are multiple voice commands that are available to perform the same task with Dragon.  Please review the table below for an explanation of how this user guide indicates optional or alternative language.

	Symbol
	Action
	Description

	[ ]
	Indicate Optional statements
	Brackets indicate Optional statements: [ ].  Optional statements are parts of the command you do not have to say for the command to work.  For example, in the command "select [this|that] word," the only words that are required for the command to work are "select word."  "This" and "that" are optional.

	( )
	Indicate Alternative (i.e., Or) statements
	Parentheses indicate alternative (i.e., Or) statements: ( ).  Or statements designate a number of alternative commands and are usually preceded or followed by other commands.  Or statements are shown by a separator bar, |, usually enclosed by parentheses.  For example, the command "open (this|file)" indicates that the user may say, "open this" or "open file."  

	|
	Separate alternative language
	The separator bar, |, is used to separate alternative language in both Or statements and Optional statements.  

	< >
	Indicate lists
	Left and right angle brackets, < >, indicate either a specific list used by the command or indicate a variable.  For example, in the command "move down <1-10> lines," <1-10> indicates that the user may select any number of lines from 1 to 10.


Table 1: Symbols Indicating Optional or Alternative Command Language
Dragon User Tips
User Tips appear throughout this user guide.  New Dragon NaturallySpeaking users may find it beneficial to review the General User Tips section, located in Exhibit A, prior to continuing with this guide.
[bookmark: _Toc336434182][bookmark: _Toc342311671]objective 1:
[bookmark: _Toc336434183][bookmark: _Toc342311672] Dragon and Word Configuration
[bookmark: _Toc336434184][bookmark: _Toc342311673]Configure Dragon for Use with Word
Overview
The Options dialog box allows you to configure Dragon to work best with your most frequently used applications.  For example, the Commands tab of the Options dialog box lets you determine whether the word "Click" is required to select menu items.
[bookmark: _Correction_Options]Correction Options
Access Dragon Correction options (See Figure 1):
1. Say, "switch to DragonBar."
2. Say, "Tools."
3. Say, "Options."
4. The Correction tab is generally the first page displayed in the Options dialog box.  To switch to the Correction tab, if necessary, say, "Correction."
"Spell" commands bring up Spelling Window.  (User preference.)  If you check this checkbox, the Spell dialog box will appear when you speak a spelling command ("spell <letters>" or "spell that <letters>").  If you pause after saying, "spell," the Spelling Window displays even if you do not check this option.
[image: Screenshot of the Correction Tab of the Options Dialog Box with a callout pointing to the Spell commands option.]
Figure 1:  Options Dialog Box – Correction Tab
[bookmark: _Commands_Options]Commands Options
Access Dragon NaturallySpeaking Commands Options (See Figure 2):
1. Say, "switch to DragonBar."
2. Say, "Tools."
3. Say, "Options."
4. Say, "Commands."
[image: Screenshot of the Commands Tab of the Options Dialog Box with a callout pointing to the Natural Language Commands button.]
Figure 2:  Options Dialog Box – Commands Tab
Natural Language Commands:  Say, "Natural Language Commands" or say, "press alt N" to activate the Natural Language Commands button.  (See Figure 2 above.)
The Enable Natural Language Commands checkbox is checked by default.  (See Figure 3.)  If it is not checked, say, "Enable Natural Language Commands" to mark the checkbox. The Enable Microsoft Word Commands checkbox is also checked by default and should be enabled for optimal speech recognition.  (See Figure 3.)  If it is not checked, say, "Enable Microsoft Word commands" to mark the checkbox.  If you disable Natural Language Commands, you can still perform all actions by voice although it will take a few extra steps.  For example, if you have not enabled Natural Language Commands, instead of saying "bold [the] last paragraph" you would need to select the last paragraph and say, "bold (that|this)."

Please note that Natural Language Commands use an additional eight megabytes of memory and require that you restart your computer before they take effect.

As a trouble-shooting step, if you experience performance issues with Dragon or with other applications while using Dragon, try disabling Microsoft Word commands.  If you continue to have trouble, try disabling Natural Language Commands.  As a practical matter, if you are a basic Microsoft Word user and do not use Word's more advanced features, you may wish to disable Natural Language Commands for better system performance.  If you are using Microsoft Word for more advanced word processing, enable Natural Language Commands and Microsoft Word commands for more efficient use with Dragon.  See the user guide entitled, "Optimizing Performance in Dragon NaturallySpeaking" for more detailed information on this topic. 
For the purposes of this user guide, we enabled both Natural Language and Microsoft Word Commands.
[image: Screenshot of the Natural Commands dialog box with callouts pointing to the Enable Natural Language Commands and Enable Microsoft Word Commands options.]
Figure 3:  Natural Language Commands Dialog Box
User Tip:
By default, Enable Microsoft Excel commands, Enable Microsoft PowerPoint commands, and Enable Corel WordPerfect commands are all enabled.  The agency does not use Corel Word Perfect, so this option should be unchecked.  In addition, we recommend that you uncheck the Excel, and PowerPoint language commands as well to maximize Dragon performance, unless you are an advanced user of these applications.  To disable these options:
1. Say, "Enable Microsoft Excel commands."
2. Say, "Enable Microsoft PowerPoint commands."
3. Say, "Enable Corel WordPerfect commands."
User Tip:
Please refer to the user guide entitled, "Optimizing Performance in Dragon NaturallySpeaking" to read more about the recommended Dragon settings to maximize your experience using Word and other applications.
[bookmark: _Formatting_Options]Auto-Formatting Options
Access Dragon formatting options (See Figure 4):
1. Say, "switch to DragonBar."
2. Say, "Tools."
3. Say, "Auto Formatting Options."
[bookmark: kanchor1202]Automatically format text checkbox should be checked.  The Automatically format text checkbox in the Auto-Formatting dialog box enables different forms of word and number formatting, allowing you to dictate things like numbers, street addresses, and Web addresses in a more natural way.  For example, the Abbreviate titles option formats "Mister" as "Mr.," and the Prices option formats "three hundred dollars and seventy five cents" as "$300.75."
You will also want to check the checkbox (i.e., enable) the following:
· Web and e-mail addresses
· Street addresses
· Abbreviate titles
· Dates.  Select "Dates As Spoken" from the list box.  Selecting "Dates As Spoken" will allow you to dictate dates in whatever format you desire, but you must be unambiguous.  For example, you must say the name of the month and not the digit if you want January 1, 2011.
· Prefer 5 million over 5,000,000
· Numbers, if greater than or equal to <0-100>.  Select "10" (ten) from the list box if you will be dictating formal correspondence.  If you are a PCOM user, you may wish to set this value to zero ("0").
· Units of measure
· Phone numbers
· Prices
· Times
· Other numbers
· Allow pauses in formatted phrases
In the SSA environment, you will generally want to uncheck the checkbox for US Social Security Numbers.  Otherwise, when you dictate a Social Security Number, Dragon will automatically add the dashes.
[image: Screenshot of the Auto-Formatting Options dialog box.]
Figure 4:  Auto-Formatting Dialog Box
[bookmark: _objective_2:][bookmark: _Toc336434185][bookmark: _Toc342311674]objective 2:
[bookmark: _Toc336434186][bookmark: _Toc342311675]Understanding the Ribbon
[bookmark: _Toc336434187][bookmark: _Toc342311676]Microsoft Office 2010 Ribbon Interface
The Ribbon Interface introduced in Microsoft Office 2007 replaced the traditional menus and toolbars in previous versions of MS Office.  The Ribbon presents commands organized in a set of tabs, and the tabs display the commands that are most relevant for each of the desired task areas.
To use the Ribbon with Word, simply say the name of the desired Ribbon tab.  For example, say, "Home" to open the Home tab or "Page Layout" to open the Page Layout tab.
Once the desired Ribbon tab is in the foreground, say the name of the function you want to access.  For example, say, "Home," and then say, "Find" to open the Find dialog box.  If you are not sure of which function an icon represents, you can position your mouse over the function and the name will display in a tool tip.  For example, in the Home tab of Microsoft Word, if you position your mouse over the capital B in the Font group, the tool tip will indicate that this icon means "Bold."
[bookmark: _Toc336434188][bookmark: _Toc342311677]Objective 3:
[bookmark: _Toc336434189][bookmark: _Toc342311678]Starting Word, Creating New Documents, Opening Documents, Changing Views, and Closing Documents
[bookmark: _Toc336434190][bookmark: _Toc342311679]Starting Word
1. Dragon now recognizes shorter names for popular Windows programs. For example, you can now say, "(open|start|launch) Microsoft Word" rather than "Open Microsoft Word 2010."  To simplify start commands or to run programs using names of your choice, you can also rename Desktop icons or create new Windows Shortcuts.  This gives you the additional option of saying, "(open|start|launch) Word" or whatever you have renamed your Microsoft Word 2010 desktop icon.
2. If you have already opened Word, but are in a different application, say, "switch to Word."
[bookmark: _Toc336434191][bookmark: _Toc342311680]Creating New Documents
To create a new document:
1. Say, "[create|open] new (document|file)."
2. Begin dictating your text.
3. See Objectives 4 and 5 to learn how to navigate your document and to format text.
User Tip:
To delete the word or phrase you just dictated, simply say, "scratch that," or "delete that."  To reverse a command or keystroke, say, "undo that."
[bookmark: _Toc336434192][bookmark: _Toc342311681]Opening Documents
General
To open an existing Word document, say, "open (document|file)."  Word will display the Open dialog box, with your focus in the File name field.  You will be in either the default directory (as set in Word Options), or in the most recently accessed directory.  Note:  Make sure the file type is set to "All Word Documents" so that you can access all types of Word documents, such as templates, which generally have a .dot or .dotx file extension. 
If you know the exact name of the desired file, dictate it in the File name field and say, "press enter."
To select the file you want to open from the List View (where all of your files and subfolders for the active folder display), say, "press shift tab" twice.  If the file or folder is visible, you can say the name of the file or folder to select it.  Alternatively, you can move through the list with any of your navigation commands (e.g., "move down three", "page down") or move to the file or subfolder by saying, "press" followed by the first letter of the file or folder.  When you have selected the desired file or folder, say, "press enter" or "press alt O."  
Changing Directories
If the file you want to open is in another directory, you will need to change the file path.  If the folder is visible on the screen, you can say the name of the folder to navigate directly to the folder.  Say, "press shift tab" three times to move the focus to the Folders list (or Tree View). 
1. Say, "[move|go] down <1-10> [lines]" until the folder in which you wish to save is highlighted.
2. Alternatively, move to the folder by saying, "press" followed by the first letter of the folder, and then saying, "press enter."  
3. To expand a folder to view its subfolders, say, "move right."  Repeat steps 2-4 until you have selected the desired folder.
4. Say, "tab" to move to the List View.  
5. Repeat step 2 or 3 until you have selected the desired file.  Say, "press enter" or "press alt O." 
A much simpler way to change the directory is to dictate the full file path in the File Name field.  For example, to open a document in the P:\worddata folder from the File Name field:
1. Say, "open (document|file)."  
2. Dictate, "p:\worddata\." 
3. Say, "press enter" or "press alt O."
4. Say, "press shift tab" twice to move to the List View.  
5. Say, "[move|go] down <1-10> [lines]" or say, "press" followed by the first letter of the file or folder until you have selected the desired file or folder.  
6. Say, "press alt O" or "press enter."  
User Tips:
You are likely to find dictating the file path challenging.  You can add your most frequently used directories to your Custom Words list (e.g., Worddata), but currently, the Dragon vocabulary will not accept the full file path (e.g., p:\worddata).  See the section below on creating a Custom Command for your most frequently used directories (file path).
To change directories, you can also dictate the file path in the Address Bar.  To move to the Address Bar, say, "press F four" or "press alt D."
Create a Custom Command for Frequently Used Directories
To avoid the challenges of dictating your file path, you can create a simple Custom Text and Graphics Command that will insert the path for you.  (See Figure 5).  In this example, we will create a Custom Command to populate the p:\worddata\ folder path to access a document called "January Data."
1. Say, "add new command."
2. In the MyCommand Name field, say the word or words you want to use for the directory shortcut: for example, say, "my directory."
User Tip:
Capitalize custom commands so that you can easily differentiate them from standard Dragon commands, which are generally lowercase.
3. Say, "cap that" to capitalize "My Directory."
4. Say, "Description" or "tab" twice to move to the Description field (optional) and add some information about your command to help you remember what the command does; for example, say, "shortcut to my directory."
5. Say, "Group" or "tab" to move to the Group field.
6. Say, "select that" to highlight User-defined.
User Tip:
Say a Group name so that you can later locate and manage your custom-created commands quickly; for example, say, "Tom commands.”
Group names cannot have spaces, so say, "cap that" to capitalize "commands" and then say, "compound that" to join the two words.
7. Say, "Content" to move to the Content field.
8. Say, "p colon backslash w o r d d a t a backslash."
9. Say, "save" or "press control s."
10. Say, "open (document|file)" or "press control O."
11. Say, "My Directory."
12. Say, "press enter."
13. Say, "press shift tab" twice to move to the List View.
14. If the file name is visible on the screen, say the file name.  For example, say, "January data."  If the file name is not visible, say, "move (down|up) <1-10> lines" until the file name highlights.
15. Say, "press enter."
[image: Figure 6 - My Commands Editor:  Screenshot of the MyCommands Editor dialog box.]Figure 5:  My Commands Editor
Alternatively, you can dictate the full path of the directory where the file is located.  In the following example, a document called "January Meeting Minutes" is located under the directory, C:\Dragon Meetings\Meeting Minutes:
1. Say, "open (document|file)" or "press control O."
2. Say, "c colon backslash d r a g o n m e e t i n g s backslash m e e t i n g m i n u t e s backslash."
3. Say, "press enter."
4. Say, "January meeting minutes."
5. Say, "press enter."
[bookmark: _Toc336434193][bookmark: _Toc342311682]Closing Documents
To close a document, simply say, "close (document|file)" or "[click] Close."
[bookmark: _Toc336434194][bookmark: _Toc342311683]Changing Views
To change to a different view of your document:

	Say, 
	To:

	"view print layout "
	Switch to Print Layout view

	"view web layout"
	Switch to Web Layout view

	"view outline "
	Switch to Outline view

	"view draft "
	Switch to Draft view


Table 2:  Voice Commands to Change Views
Note:  Dragon currently does not have a voice command for "Full Screen Reading."  Use the commands for the Ribbon, as shown in the next table, to access Full Screen Reading.
Alternatively, you can use the View tab of the Ribbon to perform the same commands.  Say, "View" to switch to the View tab, and then:

	Say,
	To:

	"Print Layout"
	Switch to Print Layout view

	"Web Layout"
	Switch to Web Layout view

	"Outline"
	Switch to Outline view

	"Draft"
	Switch to Draft view


Table 3: Voice Commands to Change Views Using the Ribbon
[bookmark: _Toc336434195][bookmark: _Toc342311684]Objective 4:
[bookmark: _Toc336434196][bookmark: _Toc342311685]Navigating and Selecting Text
[bookmark: _Toc336434197][bookmark: _Toc342311686]How to Navigate a Word Document
Since the number of voice commands is so large, it would not be practical to list all of the ways there are to navigate a Word document.  The table below shows you several examples of the many different ways to navigate your document, whether it is 1 page or 100 pages.

	Say,
	To,

	"[move] down five lines"
	Move the cursor down 5 lines

	"[go to] page thirty"
	Go to page 30

	"[move] right five words"
	Move the cursor right 5 words

	"[go to] beginning of document"
	Go to the beginning of the first page

	"[scroll] up five pages"
	Scroll up 5 screens

	"[go to] tenth paragraph"
	Go to the beginning of the 10th paragraph on the current page

	"[move to] bottom of page"
	Go to the bottom of the page you are currently on

	"page down ten"
	Page down 10 screens

	"[press] page up"
	Page up one screen


Table 4: Examples of Word Navigation Commands
[bookmark: _Toc336434198][bookmark: _Toc342311687]Selecting, Copying, Cutting, and Pasting Text
Selecting Text
To select text, move the cursor to the word, line, or paragraph you wish to select: 
1. Say, "select (word|line|paragraph)." 
2. To extend the selected text, say, "extend selection (forward|backwards|up|down) by <1-10> (words|lines|paragraphs)."
3. To reduce the selected text, say, "reduce selection (forward|backwards|up|down) by <1-10> (words|lines|paragraphs)."
4. You can also say, "select (next|previous) <1-10> (words|lines|paragraphs)."
User Tip:
You can also select a phrase or sentence by saying all or part of the sentence you want to select.  For example, to select "registration begins at five," in your document, you can say, "select registration begins at five" or say, "select registration through at five."
Copying Text
To copy selected text, say, "copy [this|that]" or "press control V."
Cutting Text
To cut selected text, say, "cut [this|that]" or "press control X."
Pasting Text
To paste selected text, move your cursor to the insertion point and say, "paste [this|that]" or "press control V."
[bookmark: _Toc336434199][bookmark: _Toc342311688]Objective 5:
[bookmark: _Toc336434200][bookmark: _Toc342311689]Formatting and Fonts
[bookmark: _Toc336434201][bookmark: _Toc342311690]Formatting Text
Because the number of valid Natural Language Commands is so large, there are multiple voice commands to format text.  For example, you can bold a line of text by selecting (i.e., highlighting) the text and saying, "bold this" or by saying, "bold [the] first line."  For each of the formatting options below, we have provided examples of only one or two of the many ways to format text.

	To:
	Say,

	Turn on bold
	"bold on" or "press control B"

	Bold text
	"bold <word>"

	Turn on underline
	"turn on underline" or "press control U"

	Underline text
	"underline <word>"

	Turn on italics
	"italicize that" or "press control I"

	Italicize text
	"italicize line"

	Turn on strikethrough
	"turn on strikethrough"

	Strikethrough text
	"strikethrough  the first sentence"

	Set font style
	"set font to <font style>"

	Change font style
	"set font size to <font style> in the last paragraph"

	Set font size
	"set font to twenty two points on the last page"

	Change font size
	"set font size to fourteen points in the document"

	Change font color
	"change this to blue"

	Change case
	"change that to uppercase"

	Change line spacing
	"double space second paragraph"

	Change paragraph spacing
	"single space selection"

	Align text left
	"left align first paragraph"

	Align text right
	"right align this"

	Center text
	"center the second sentence"

	Justify text
	"justify document"

	Set initial indent
	"set initial indent to one (inch|centimeter) on document"

	Set hanging indent
	"set hanging indent to one (inch|centimeter) on this page"

	Create a bulleted list
	"bullet that"

	Create a numbered list
	"number selection"


Table 5:  Word Formatting Options
User Tips:
To undo formatting, simply say, "un" in front of the formatting command.  For example, to unbold the first paragraph of your document, say, "unbold [the] first paragraph."  Another way to undo formatting is to use the "delete" command.  For example, to remove all bulleted lists from a document, say, "delete bullets from [the] document."
You can also change the Page Layout options by navigating the Ribbon to the Page Layout dialog box.  For example, to change your page orientation to landscape, say, "Page Layout," "Orientation" and then "Landscape."
[bookmark: _Toc336434202][bookmark: _Toc342311691]Objective 6:
[bookmark: _Toc336434203][bookmark: _Toc342311692]Adding Headers and Footers
[bookmark: _Toc336434204][bookmark: _Toc342311693]Adding a Header to Your Document
To add a header to your document, use the Insert tab of the Ribbon:
1. Say, "Insert."
2. Say," Header."
3. Say, "Edit Header."
4. Dictate or type the text you would like to appear in your header.
5. Say, "close header" or "press escape" to close the header.
User Tip:
You can also add a header to your document by doing the following:
1. Say, "go to header."
2. Dictate the text you want to appear in the header.
3. Say, "close header " or "press escape."
[bookmark: _Toc336434205][bookmark: _Toc342311694]Adding a Footer to Your Document
To add a footer to your document, use the Insert tab of the ribbon:
1. Say, "Insert"
2. Say, "Footer."
3. Say, "Edit Footer."
4. Dictate or type the text you would like to appear in your footer.
5. Say, "close footer" or "press escape "to close the footer.
User Tip:
Another way to add a footer to your document is to do the following:
1. Say, "open footer."
2. Dictate the text you want to appear in the footer.
3. Say, "close footer" or "press escape."


[bookmark: _Toc336434206][bookmark: _Toc342311695]objective 7:
[bookmark: _Toc336434207][bookmark: _Toc342311696]Saving Documents
[bookmark: _Toc336434208][bookmark: _Toc342311697]Saving Your Word Document
Initial Save
The first time you save a file, Word will open the Save As dialog box.  (See Figure 6.)  If the default folder (e.g., p:\worddata) and file format are correct, you simply need to dictate the name of your document in the File name field.  
1. Say, "save (document|file)."
2. When the Save As dialog box opens, you will be in the default directory (as set in Word Options) or in the most recent directory you accessed since starting Word.  The Save as type will be "Word Document (*.docx)" (or the default file type you set in Word Options). 
3. Dictate the name of the file in the File name field.
4. Say, "Save."
Saving to a Different Directory
There are multiple options for saving your document to a different file directory, either during the initial save or subsequent saves.  
You can change the selection in the Folder or File list in the Save As dialog box.  To navigate by voice directly to a folder, the folder must be visible on the screen.
1. Say, "save (document|file) as."
2. Dictate the name of the file.
3. Say, "press shift tab" three times to move the focus to the Folders list (or Tree View). 
4. Say, "(move|go) down <one-ten>" or "down <one-ten> lines" until the folder in which you wish to save is highlighted.
5. Alternatively, move to the folder by saying, "press[X]," where X is the first letter of the folder, and then saying, "press enter."  
6. Say, "Save" or say, "press alt S."
A much simpler way to change the directory is to dictate the full file path, along with the name of the document.  For example, to save the document to the P:\worddata folder:
1. Say, "save as."
2. Dictate, "p:\worddata\[file name]."
3. Say, "save" or "press alt S."
User Tips:
You are likely to find dictating the file path challenging.  You can add your most frequently used directories to your Custom Words list (e.g., Worddata), but currently, the Dragon vocabulary will not accept the full file path (e.g., p:\worddata).  See "Create a Custom Command for Frequently Used Directories" in Objective 3 for instructions on creating a Custom Command for your most frequently used file paths.
To change directories, you can also dictate the file path in the Address Bar.  To move to the Address Bar, say, "press F four" or "press alt D."
To move to the List View (where all of your files and subfolders for the selected folder display), say, "press shift tab" two times (instead of the three times required to move to the Tree View).


[image: Description: Figure 7:  Screenshot of the Save As dialog box with callouts pointing to the tree view and the list view.]
Figure 6:  Save As Dialog Box
Subsequent Saves
Save your document frequently as you work.  Saving the document as you go will overwrite the original file, maintaining its current location and file type, and keep the most current version of your document.
1. Say, "save (document|file)."

To avoid the challenges of dictating your file path, you can create a simple Custom Text and Graphics Command as described in Objective 3, "Create a Custom Command for Frequently Used Directories," that will insert the path for you.  In this example, we will save a document named "January report" under p:\wordata\ using the custom voice command "My Directory."

1. Say, "save (document|file)."
2. Say, "My Directory."  
3. p:\worddata\ displays in the File name field.
4. Say, "January report."
5. .docx files are the default setting.  See the next section to find out how to save your document as a different file type.
6. Say, "[click] Save" or "press alt S."
7. As you continue to make edits to your document, say, "save (document|file)" to save your changes.
[bookmark: _Toc336434209][bookmark: _Toc342311698]Saving a Word Document as a Different File Type
To save a Word document as a file type other than the default:
1. Say, "save [file|document] as."
2. Dictate the name of the file (if you wish to change it).
3. Say, "Save as type" or say, "[press] tab" to move to the Save as type field.
4. Say, "drop list" or say, "press down arrow."
5. Say, "(move|go) down <one-ten>" or "down <one-ten> lines" until you have selected the desired file type.
6. Say, "press enter."  The file name now displays the extension of the file type you selected: for example, .html instead of .docx.
7. Say, "Save" or "press alt S" to save your new file.

[bookmark: _Toc336434210][bookmark: _Toc342311699]Objective 8:
[bookmark: _Toc336434211][bookmark: _Toc342311700]Printing Word Documents
[bookmark: _Toc336434212][bookmark: _Toc342311701]Using the Print Preview Feature
To preview your document before printing:
1. Say, "view print preview" or "preview (document|file)." 
2. Make any Print, Page Setup or other formatting changes to your document.
3. Say, "Close [Print Preview]"or "press escape" to exit Print Preview mode.
[bookmark: _Toc336434213][bookmark: _Toc342311702]Printing a Document
To print your document:
1. Say, "print (document|file)"or "press control P."
2. The Print dialog box displays.
3. To change the number of copies, say, "Number of copies" or "press alt C" and then say the desired number of copies.
4. To specify a page number or range of pages, say, "Pages," and then say, "<page number>," or "<starting page number> hyphen <ending page number>."
5. Say, "[click] OK" to print your document.  
User Tip:
For numbers 1-9, you must say, "numeral" before the number so that Dragon recognizes it as the numeric form and not as text.  For numbers 10 and greater, you do not have to say, "numeral" before the number.
[bookmark: _Toc336434214][bookmark: _Toc342311703]objective 9:
[bookmark: _Toc336434215][bookmark: _Toc342311704]Spell Check and AutoCorrect Options
[bookmark: _Toc336434216][bookmark: _Toc342311705]Check Spelling and Grammar
To check the spelling of your document:
1. Say, "check (spelling|grammar) or "press F seven."
2. As each word displays in the Spelling and Grammar dialog box, say the name of the button, checkbox, or field to indicate your response.  For example, to ignore all instances of a flagged word, say, "Ignore All."  To move to the Suggestions list, say, "Suggestions."
3. Complete this process until the "The spell and grammar check is complete" message displays. 
4. Say, "[click] OK."
User Tip:
To disable the grammar check and only check spelling, when the Spell Check dialog box displays say, "Check grammar" or "press alt K" to uncheck the checkbox.
[bookmark: _Toc336434217][bookmark: _Toc342311706]AutoCorrect Options
To change your AutoCorrect settings:
1. Say, "File Tab."
2. Say, "[click] Options."
3. Say, "Proofing."
4. Say, "AutoCorrect Options" or "press alt A."
5. To move between the pages in the AutoCorrect dialog box, say the name of the tab to move to that page.  For example, to go to the AutoFormat as You Type tab, say, "AutoFormat as you Type." 
6. To check or uncheck a checkbox within AutoCorrect options, say the name of the checkbox.  For example, to deselect Automatic bulleted lists, say, "Automatic bulleted lists" to uncheck the checkbox.  To move to buttons or edit fields, say the name of the button or field.  
7. Say, "[click] OK."
8. Say, "[click] OK."
[bookmark: _Toc336434218][bookmark: _Toc342311707]objective 10:
[bookmark: _Toc336434219][bookmark: _Toc342311708]Using Find and Replace
[bookmark: _Toc336434220][bookmark: _Toc342311709]Searching for Words or Phrases
To search for a specific word or phrase in your document:
1. Say, "find and replace" or "press control H."  
User Tip: 
In previous versions of Word, simply saying, "find word" opened the Find and Replace dialog box.  However, in Word 2010, "find word" or "press control F" now opens the Navigation Pane.  Generally speaking, it is easier to navigate by voice in the Find and Replace dialog box than in the Navigation Pane. 
2. Word displays the Find and Replace dialog box, with your cursor in the Find what field of the Replace tab. 
3. Say, "Find" or "press Alt D" to move to the Find tab.
4. Dictate the word or phrase you wish to find in your document.
5. Say, "Find Next" or "press alt F."
6. When you are finished, say, "[click] Cancel," "[click] Close," or "press escape."
[bookmark: _Toc336434221][bookmark: _Toc342311710]Replacing Words or Phrases
To find and replace a specific word or phrase in your document:
1. Say, "replace," "find and replace," or "press control H."
2. The Find and Replace dialog box opens with your cursor in the Find what field of the Replace tab. 
3. Dictate the word or phrase you wish to find in your document.
4. Say, "Replace with" or "[press] tab" to move to the Replace with field.
5. Dictate the word or phrase with which you would like to replace the previous word or phrase.
6. If necessary, say, "press alt" or "press escape" to close the list box.
7. Say, "Find Next" or "press alt F" to move to the next instance of the word or phrase.  Say, "Replace" or "press alt R" to replace the found instance of the word or phrase.  Say, "Replace All" or say, "press alt A" to replace all instances of the word or phrase.  
8. Word will display one of several messages.  Say, "Yes" if asked whether you want to search the remainder of the document or search from the beginning of the document.  Say, "OK," when you get the message that Word has finished searching the document.
9. When you are finished, say, "[click] Close" or "press escape" to close the dialog box. 
[bookmark: _Toc336434222][bookmark: _Toc342311711]Objective 11:
[bookmark: _Toc336434223][bookmark: _Toc342311712]Working with Tables
[bookmark: _Toc313358522][bookmark: _Toc336434224][bookmark: _Toc342311713]Creating a Table
To create a table, move the cursor to the location where you want to insert a table.  Say, "create [a] table."  Then say the name of the field or say, "[press] tab" or "tab [key]" to move between the fields; complete the fields and say, "OK."  Alternatively, say, "create [a] <number of columns> by <number of rows> table."
The following voice commands allow you to modify and format your table.  Keep in mind that the cursor must be in the correct position before saying the commands.  In addition, since there are so many different ways to accomplish each task, the commands listed are only one example of a voice command for each task.

	To:
	Say,

	Add a row
	"add a row (above|below)"

	Add a column
	"insert five columns to [right|left]"

	Delete a row
	"delete this row"

	Delete a column
	"delete [the] third column"

	Move left or right
	"move right three columns"

	Move up or down
	"go down six rows"

	Move to a different row
	"go to tenth row"

	Move to a different column
	"go to last column"

	Hide a row
	"hide this row"

	Move to the first or last cell
	"[go to] last cell"

	Move to a different table
	"[go to] next table"

	Sum a column
	"sum up column"

	Sum a row
	"sum up [this] row"

	Delete a table
	"delete table"


Table 6:  Sample Table Commands
User Tip:
Many of the formatting commands described in Objective 5, Formatting and Fonts, also work with tables.  
[bookmark: _Toc336434225][bookmark: _Toc342311714]objective 12:
[bookmark: _Toc336434226][bookmark: _Toc342311715]Working with Multiple Documents
[bookmark: _Toc336434227][bookmark: _Toc342311716]Toggling Between Multiple Documents
Whether you have two documents open or ten, it is easy to toggle between different Word documents using Dragon.  The easiest way to switch between documents is to:
1. Say, "press control F six" or "switch to Word."
2. Repeat Number 1 until the desired document is in the active window.
Alternatively, utilizing the View tab of the Ribbon you can:
1. Say, "View" or "press alt W."
2.  Say, "Switch Windows." 
3. The Switch Windows menu displays a numbered list of all of your open Word documents.
4. Say, "press <one-nine>," where <one-nine> is the number of your document in the list.  Alternatively, you can say, "[move|go] (up|down) <one-ten> lines" until you have selected the document you want; then say, "press enter."


[bookmark: _Toc336434228][bookmark: _Toc342311717]exhibit a - general user tips
If Dragon has difficulty in recognizing a commonly used word or phrase and you have tried correcting the misrecognition at least twice, use the train word feature to teach Dragon how you pronounce it.
1. Say, "train word."
2. Type or dictate the desired word or phrase.
3. Say, "Train."
4. Say, "Go."
5. Say the word as you would normally say it.  Try not to over-enunciate.
6. Say, "Done."
In order to "Train" the word, it must be part of your vocabulary.  If it is not part of your vocabulary, you can add individual words to your vocabulary by using the add word feature.
1. Say, "Add Word."
2. Type or spell the word, and say, "OK" And then "Done." 
By default, Dragon enables the "I want to train the pronunciation of this word or phrase" checkbox.  It is not necessary to train every new word you add because Dragon will predict the pronunciation.  If Dragon does not recognize the words correctly, you should train them.  Be sure you save your user files after adding new words to save your changes.
Say, "press alt" to close a drop down menu or move from the Menu Bar. 
In addition to Dragon voice commands, you can speak the access keys (the underlined letter in many menus and dialog boxes) to perform many tasks.  For example, say, "Tools" or say, "press alt T" to access the Tools Menu in the DragonBar.
[bookmark: _Toc336434229][bookmark: _Toc342311718]exhibit B- keyboard shortcuts
Below is a table showing some of the commonly used Keyboard Shortcuts for MS Word.  For a complete list of Keyboard Shortcuts:
1. Say, "press F one."
2. Say, "search."
3. Say, "keyboard shortcuts."
4. Say, "2."
5. Say, "keyboard shortcuts."
6. Say, "1."

	To:
	Say, "press…"

	Create a new document
	"control N"

	Open a document
	"control O"

	Save a document
	"control S"

	Close a document
	"control W"

	Print a document
	"control P"

	Find word or phrase
	"control H" and then say, "Find"

	Print preview a document
	"press alt control I"

	Find and replace a word or phrase
	"control H"

	Check spelling and grammar
	"F seven"

	Turn on bold
	"control B"

	Turn on italics
	"control I"

	Turn on underline
	"control U"

	Align text left
	"control L"

	Align text right
	"control R"

	Center text
	"control E"

	Justify text
	"control J"

	Close Word
	"alt F four"


Table 7:  Keyboard Shortcuts
[bookmark: _Toc336434230][bookmark: _Toc342311719]Exhibit C - phonetic alphabeT
	[bookmark: _Hlk309029176]To Type:
	Say, "press..."

	a
	alpha

	b
	bravo

	c
	Charlie

	d
	delta

	e
	echo

	f
	foxtrot

	g
	golf

	h
	hotel

	i
	India

	j
	Juliet

	k
	kilo

	l
	Lima

	m
	Mike

	n
	November

	o
	Oscar

	p
	papa

	q
	Quebec

	r
	Romeo

	s
	sierra

	t
	tango

	u
	uniform

	v
	Victor

	w
	whiskey

	x
	X-ray

	y
	Yankee

	z
	Zulu


[bookmark: _Toc505590159][bookmark: _Toc506778872][bookmark: _Toc55711387][bookmark: _Toc59510475][bookmark: _Toc71691254][bookmark: _Toc75157225][bookmark: _Toc78861496][bookmark: _Toc149032061][bookmark: _Toc242763556][bookmark: _Toc301870227][bookmark: _Toc309373624]Table 8:  Phonetic Alphabet
[bookmark: _Toc336434231][bookmark: _Toc342311720]FEEDBACK SHEET
Request to the instructor: 
As you use this training package, please document errors, omissions, and revisions and notify us of any required editing.  At the completion of this segment, you should mail this form to the address on the next page.
[bookmark: _GoBack]Source of report: 
Location of training:  _______________________________
Your name:  _____________________________________ 
Your phone number:  ______________________________ 
Timeframes: 
How much time did it take to present this material?
Topics: 
Is there any material in the lesson that is covered but not relevant to your position that we should remove?  If so, what?
Can you identify any topic not covered in this lesson that should be included?
Complexity level: 
Are there any lessons that appear either too simple or too complex?  Which ones?  Why?
Testing: 
How would you rate the usefulness of the tests and exercises?
              1              2                3                4                5
Irrelevant                    Adequate                  Quite helpful
Please note your corrections below or attach a photocopy of corrected pages.
Page #	Correction Needed
Comments: 
Use the space below for your comments on how we can improve this material.
Mail to:
Gregory Gill
Social Security Administration
EHR Ste 100	
6401 Security Blvd.
Baltimore, MD 21235
Or e-mail comments to gregory.gill@ssa.gov
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